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Welcome to DB-Text

Import, export and manage text data table

DB-Text is able to manage the most common used format for data, the text based 
format, often used to distribute small and medium size data collections.

Using and distributing data in text format is commonly accepted.
Unfortunately these data are not easily managed opening them using text editors.

DB-Text allows to import these data in text format inside DB-Text documents and 
manage them in a dedicated fast and easy way.
DB-Text can import data both in CSV (comma separated value)  text format or in 
TSV (tab separated value) text format, automatically recognizing the right format if 
necessary.

Data can be manipulated and exported as text (as they were imported) or saved 
inside a native DB-Text document
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Getting Started with DB-Text

Using Demo documents

Launch DB-Text.

Open a new document.

Select ‘Import from Text’ from the toolbar

Select a text file to import 
(we created a tabbed text file sample using our own Data Creator available for 
download at http://www.ecleti.com).
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Select the ‘AutoDetect’ format  and press Open.
This will automatically use the correct importer for the internal data format.

Immediately the open dialog will close and another following dialog panel will open 
showing you the available options to import the data inside the file.

You are importing in a new document without previous table columns available, so 
we can choose to import in a new column for any field to import.

We can navigate the data that we are importing record by record (row by row) (using 
the two arrows at the base of the Available Records section)

In case the first record in the file to import, was used for the field names, we’ll chose 
to use the first record in the imported data as header for our data, selecting the box 
‘First Row as Field name’

Then press ‘Import’
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The data will be immediately imported and displayed in the document, ready to be 
viewed, edited and saved in native format or exported in text format.

And the column names will be adjusted in accordance (if we used the ‘Use first 
record for header’ option) with the first row values.
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You can import a text file inside a document also drag and dropping the file from the 
finder to the document window
In that case, after you drop the file over the document window, the usual import 
sheet will open to start the import procedure as already seen.

DB-Text Reference
About the app

DB-Text is a software to manage data in text format.
DB-Text can:
• Import data in the most common used format for data
• Edit and manage it inside an editable table where the user can modify data, 

including editing single fields, adding and removing records (rows), adding and 
removing fields (columns)

• Browse data, sorting and searching contents.
• Exporting data in text format.

Document based

DB-Text is document based
Inside any document the user can save the data and the structure of the database
Data can be imported and exported at any time in text format.

Import

To import data select ‘Import from Text’ from the toolbar or from the File menu

An ‘Open dialog’ will allow to select the file to import and the format of the data 
inside the text file

NOTE:
You can import a text file inside a document also drag and dropping the file 
from the finder to the document window!
File must be named with final extension: txt, text, csv, tsv, TXT, TEXT, CSV, 
TSV to be accepted

You can chose the encode used for the file or select AutoDetect
Files coming from other platforms or some Microsoft applications can use different 
encode then the standard UTF8 format used by default on macOS

Three formats are available to import:
• The ‘TSV ‘ tab separated value format where any field is separated by a ‘Tab’ char. 

Records are separated by newlines
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• The ‘CSV’ comma separated value format where any field is separated by a 
comma and any field can be embedded between double-quotes. Records are 
separated by newlines

• The CSV-S char separated value using semicolon
• It is available also an AutoDetect option that analyze the internal file content and 

try to use the right format to import

DB-Text can correctly import also files from MS Windows file created with the DOS 
format for newline.
The following file extensions are accepted in the file to import:
txt, text, csv, tsv, TXT, TEXT, CSV, TSV

If the file you need to import has a different extension you can change it manually in 
the finder to one recognized listed above, to let DB-Text recognize it as importable.

After selecting the file a successive dialog is visualized allowing the user to indicate 
where to insert the imported data column by column

On the left there is a visualization of the data in the ‘Data to Import’ area
The user can browse record (row) by record all the records being imported

A record (row) in the text file to import, is represented inside this dialog in a column 
view for layout requirements
An indication of the number of records (total rows in the text file) to be imported is 
displayed at the bottom of the ‘Data to Import’ area
This allow to browse what is going to be  imported to better take decisions

DB-Text User Guide  © 2012-2025 Ecleti - Roberto Panetta page 7



On the right, in the ‘Target Fields’ area, it is possible to indicate where, field by field, 
to insert the data.
A popup allow to select between all the fields already available in the document or to 
import inside a new column (to be created on the fly during import ) or to do not 
import at all a field.

This must be indicated for any field you are going to import (remember: a ‘field’ is a 
column inside the text file you are importing and is a column in the table where you 
are importing) 

In a new created document we will not have columns already inside, so the user will 
have to choose only between ‘DO NOT IMPORT’ and ‘IMPORT TO NEW COLUMN’ 
for any field

A popup at the bottom of the ‘Target Fields’ allows to set all the fields as ‘DO NOT 
IMPORT’ or ‘IMPORT TO NEW COLUMN’ for all the fields with a single click and 
then modify then manually to further customize them.

When importing in a document, you can choose to use the first imported row as 
names to assign to newly created columns
In that case new columns will be created with the names in the first row of data to 
import

If you already have columns the ‘First Row as New Col Name’ applies only to newly 
created columns
Previously created columns will not change their name
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In release previous to 1.8 ‘First Row as New Col Name’ were applicable only to 
documents with no columns at all inside

Using ‘First Row as New Col Name’ the ‘Do not import first row’ is checked and 
disabled.

If you are importing in an already created database (with columns already available)
you will have available the commands:
Cascade Assignment
and
Guess Target from First Row

The ‘Cascade Assignment’ allows to assign as destination for any column imported 
a destination field, starting from the first available to the last one in a cascade style
It can be useful importing many text files, all equally formatted to be imported in the 
document, and to avoid to assign to each all the time the fields, which were created 
exactly to receive the imported files (maybe using the first of the imported file to 
create all the required fields)

The ‘Guess Target from First Row’ command, reads the first row of the imported 
data and looks for columns inside the database with the same name and assign the 
correspondent data column in the imported data to the column in the destination 
database

If you select ‘Guess Target from First Row’, the ‘Do not import first row’ will be 
selected automatically because the application assumes this row contains the fields 
name and not data to import.

In case the name is already assigned but we don’t need to import the first record 
(probably because it was still used to specify column names) we can simply use the 
‘Do not import first row’ option

Pressing import will import the data inside the document as set in the import dialog.

Edit data
DB-Text User Guide  © 2012-2025 Ecleti - Roberto Panetta page 9



Data are presented inside an editable table

any field in any record can be edited with a double click

Record (rows) can be deleted at any time selecting them and pressing the ‘-’ button 
at the bottom of the data table
Multiple record can be selected and deleted, even all the records inside the 
document.

Empty record can be added pressing the ‘+’ button and deleted with the ‘-‘ button.

Records can be selected using the mouse and at the bottom an info string indicates 
how many rows are selected of the available records.
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Columns can be added from the ‘Data’ menu or from the popup at the bottom of the 
window

Adjust  data

Data can be adjusted aligning them inside a column.
To align a column select it pressing the alt key and clicking the column header
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After selecting the column use the toolbar or the menu to change the column 
alignment.

Browse and search data
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Data are presented in a table with fields represented in a columns and records in 
rows
The user can sort by the column content clicking in the header.

Data can also be searched using the search field in the toolbar
Only the records (rows) containing the search string will be displayed in the table

To go back to show all, simply reset the search string clicking the cross inside the 
search string or press the ‘Show All’ button

Search string used frequently can be saved inside the popup menu inside the 
search field
To save a term press Enter inside the search field when a string you want to save is 
inside the field

The string will be now available inside the popup menu
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To delete all the term saved inside the popup select ‘Clear Saved Searches’ from 
the popup menu.

Column length of the table can be adjusted positioning the mouse in the column 
header or using the ‘Column Length’ slider in the toolbar

Using the toolbar ‘Column Length’ control you adjust all the columns in a single 
command increasing or decreasing any columns width. The difference between the 
columns width, you manually adjusted using the mouse, is maintained over use of 
the ‘Column Length’ control.
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Column lengths are remembered by documents.

Sort data

To sort data inside the table, click the header of any column and the table will be 
ordered by the clicked column.

Data can be sorted using 3 methods:
Standard, Localized, Localized case insensitive
You can adjust the method in the preferences.

To restore the table to the original situation, as when imported, you can use the ‘Sort 
Using Import Order’ command under the menu or the command pop-up at the 
bottom of the document window and the data will be sorted in the order they had 
when imported.

Please note that this features was introduced since release 1.11 of DB-Text
Documents created with previous release has not that order stored in memory, so 
only after a new import an old documents start to remember the ‘import order’ of 
data for the new imported data.

Structure of the database

To edit the structure of the database the user has available a dedicated view where 
to inspect and edit the fields (columns) in the database.
To access it press the key icon at the left top of the window (or select ‘Edit Columns 
Header’ from the ‘Data’ menu

An area where is possible to edit the column name ‘Columns Name’ is available.
To edit a field (DataBase column) double click it
As soon as a field name is changed, the column name in the header of the database 
column is updated in accordance
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Fields can also be created or deleted using the buttons at the bottom of the 
‘Columns Name’ area

Creating a new field in the database insert a new column in the database table
Deleting a field delete a column in the database table, will destroy all the data inside 
the column in the database!
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Column can also be deleted selecting a column (using alt-click) and selecting 
‘Delete Selected Column’, the result will be similar to selecting the column name 
and pressing the ‘-’ button in the ‘Columns Name’ table

Column can also be moved using the Up and Down key.

To move a column (left and right) move the correspondent Key Column (up and 
down).
To move a column to the left, move the key up.
To move a column to the right, move the key down.

DB-Text User Guide  © 2012-2025 Ecleti - Roberto Panetta page 17



At any time a row (record) of the database can be used as column name for the 
database
Simply select the row and use the ‘Use selected row as header’ from the menu or 
the popup at the bottom of the window

Exporting data

To export data on file use the ‘Export to Text file’ command from the ‘File’ menu

All the filtered records, visualized inside the table at the current time will be 
exported.

You can also export All records selecting  ‘Export All to Text File’ from the ‘File’ 
menu.

In any case opening the export dialog the application will show how many records 
are going to be exported.

The export dialog allows to select which fields to export and the field order to use to 
export data.

To use a file to export, simply move it to the right list.

You can change the field order using the up and down button at the foot of the right 
list
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When you have done you can proceed to the next step pressing ‘Continue’.

You can select in the dialog the format to use:

• Tab Separated Value
• Comma Separated Value with Quotes
• Comma Separated Value no Quotes
• HTML Table
• Full page in HTML containing a table
• Custom format where you can specify the separator you like

You can also select the option  to insert the column names as the first row in the text 
file to export.
Later, importing the file, the first record can be used as column names the importing 
application can provide that
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Text data can be also copied in the clipboard for the selected rows, this is a sort of 
‘export via the clipboard’.
The user can select one or more rows and select from the menu, or the bottom 
popup, the commands: 
‘Copy Selected Row as Text (Tab)’ or
‘Copy Selected Row as Text (CSV) with Quotes’ or
‘Copy Selected Row as Text (CSV) no Quotes’ or
‘Copy Selected Row as Html Table Rows’
‘Copy Selected Row as Html full Table Page’ 

All the data of the selected rows will be copied in the clipboard in the requested 
format ready to be used in other applications.

The modern macOS features

DB-Text adopts and makes use of the latest Apple technologies available in macOS
They are used in the standard Apple way, so nothing new to learn if you already 
know how  to use them.

• Resume – the app will reopen at the point and state the user left it included 
opened documents and unsaved one

• Auto save – the app saves using the macOS autosave functionality 
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• Versions – the user can look at previous versions of documents and restore to any 
earlier version (just select Revert to Saved from the menu or the down arrow at the 
right of the title window, it appears only if you move the cursor over)

To use the Versions you can select from the ‘File’ menu ‘Revert To >  Browse All 
Versions’

• Full Screen - the user can switch at any time to full screen  using the native 
macOS full screen mode and commands (use the upper right icon in the window to 
go full screen and bang the mouse in the upper part of the screen to re-obtain the 
menu and eventually clicking the standard icon to exit the full screen mode)
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Dark Appearance and Light Appearance Mode

This application is also fully compatible with Dark and Light Appearance Mode 
available on macOS from macOS 10.14 Mojave and successive.

You can switch at any time from one mode to the other

Preferences

General

Specify the action to do at startup

• Standard Behaviour (with auto-resume)
• Open Dialog if No resume
• Open Dialog Always
• Open Selected preferred document

At any successive relaunch the app will execute the option selected.

The additional three buttons at the foot of the edit field let you:
• Show in the finder the selected file
• Test open the selected file as it will be done at the next application launch
• Clear the selection

To select a document press the select from disk button and select it from the open 
dialog that will follow

The reference to the file is taken using scooped bookmarks and they work even if 
you move the file on your disk, even if your file is in the trash.
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To update the path display in case the file was moved,  click the ‘show in finder’ or 
the ‘test open’ button

To select a document you have 3 way: 
• Pressing the select from disk button and select it from the open dialog that will 

follow
• Dragging it from the finder or dragging it using the proxy icon (the icon in an 

opened document in the title bar)
• Editing it in the edit field (the hard way)

At any successive relaunch DB-Text will execute the option selected.
The additional two buttons at the foot of the edit field let you:
• Show in the finder the selected file
• Test open the selected file as it will be done at the next application launch

Advanced

The advanced section allows to select the sort method to sort data inside the 
document table using a column content, simply clicking the column header.

The 3 methods are:
Standard Case Sensitive
Localised (depends of your country settings)
Localised Case Insensitive

If you change it, the changes is in effect from the next column header click
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Update

* Update section in the preferences is not available in the App Store Release 
(if you purchased via the App Store you don’t need it, to obtain an update 
use the App Store Update function) 

DB-Text can inform you if an update is available.
If enabled, the application will check no more then once a day.

If you download the upgrade, you need to install it.
A common error is to download an upgrade and install it maintaining the old 
application somewhere on the hard disk.
Then using to open the documents sometime the old application and sometime the 
new one. This cause some problems*. To avoid it simply install your application in 
the place dedicated to it, the Application folder. When you install an update on the 
standard Application folder, the system will ask if you want to replace the old one 
with the new, answering yes will install the new one replacing the old.

*If the application says the document you are trying to open was created with a newer 
version of the application, probably you have two different release of the application on your 
Hard Disk and you are trying to open a document with the older version after having 
modified the document with the new one. When you receive a similar message open the 
about box inside the application and see if you are running the last release. In case 
download it, install it and USE it!

Help
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DB-Text provides a PDF user guide under the Help menu

Under the help menu use the Visit Site  to access our site a download the very last 
version of DB-Text and other software for Mac we make.

 

Support
 
You can also obtain support using the ‘Support Email...’ command. An email will be 
prepared using your email client with the correct address to send to.
Yes, we answer to your emails.

About Tension Software and Ecleti

All the software asset by Tension Software is now under Ecleti 
New company name but still the same owner and main developer (Roberto Panetta)
So for the users nothing changes. We provide the same software and the services. 
All the user licenses are valid and assistance is provided as before to all our users.
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